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THE EDITING SYSTEM 
 

Editing Software: Adobe Premiere Pro CS6 
   C:\programme files\adobe\premiere 
 

Premiere Pro CS6 can open projects from earlier versions of Premiere,  
a CS6 project should open in CS5 version of Premiere,  

but you cannot save a CS6 project as an earlier version. 
    
The HELP MANUAL can be accessed in the program at: 

HELP > ADOBE PREMIERE PRO HELP 
USE IT! Here you can find out very useful information. 
If you are connected to the internet you will be able to access further information from here. 
 
 
 

BEFORE STARTING A NEW PROJECT 
 

 Your working drive for Premiere Pro files is best on the internal D drive. 

 Use an external drive for backing up your complete project. 

 Create a folder for ‘Premiere Editing’ if it does not already exist. 

 It is sensible at the end of a project to back up your Project folder containing ALL your 
working files. 

 Premiere Pro needs enough space on the C drive to work efficiently so avoiding putting too 
many other programs on the computer. 

 It is also sensible to have a folder on the C drive (i.e. on a separate section of the 
computer) where you back up your project file at the end of each editing session. 
You can also save this project file on a separate external drive on even a ‘pen 
drive’. This is in addition to the auto-backups which Premiere Pro creates.  

 These archive backups can be used to re-create a project if your computer 
crashes. 

 Use a separate hard drive to create archives of your camera footage. 
 
 
 

IF YOU ARE TRANSFERRING FROM VIDEOTAPES…  
 

 Do you need the camera attached (and switched on)?  
Either because you need to input footage or because you need to output the finished 
programme onto videotape. 

 It is better to power the camera from mains when you are editing preferably plugged into a 
UPS in case the power fails. 

 Connect the camera to the computer (before going into Premiere) using the four pin firewire 
cable. Ensure the camera is in playback mode. 

 The computer will recognise the camera and you can control the tape from the computer. 
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WHEN YOU START PREMIERE PRO  
 

If this is a new project double click on the Adobe Premiere Icon on the desktop, select ‘new 
project’ from the opening screen.  
 

In the NEW PROJECT SCREEN there are 2 tabs: General and Scratch Disks 
At the bottom of the screen there is information for the location and name of the project. 
At LOCATION: select the folder Premiere Editing and create a folder for the whole PROJECT. 
At NAME: give a name to the project (usually the same as the project folder). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
These settings can also be accessed within the Premiere screen by going to : 
Project > Project Settings 
 

 
 
In the GENERAL tab:  

 For LOCATION: browse and select 
the Premiere Editing folder on the D 
(or E) drive, and create in this a 
working folder for your PROJECT 
(the name of the project). 

 For NAME: Type the name of the 
project and select the location of the 
working folder that you created.  

 Ensure Video, Audio and Capture 
tabs are correctly selected. 

 

In the SCRATCH DISKS tab:  

 For Captured Video, select the 
project folder you created and then 
within this, make a new folder called 
FOOTAGE. 

 For Captured Audio select the 
FOOTAGE folder you have just 
created. 

 For Video Preview, select the 
project folder you created and then 
within this, make a new folder called 
PREVIEWS. 

 For Audio Previews select the 
PREVIEWS folder you have just 
created. 
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When you click OK the screen goes through to the NEW SEQUENCE options window. 
 
In the NEW SEQUENCE SCREEN there are 3 tabs:  
Sequence Presets, General and Tracks 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
In the SEQUENCE PRESETS tab:  

 Select the correct sequence  
format :        

 For SD AVI footage files use 
DV-PAL Widescreen 48Khz 
(or Standard 48Khz if you are 
working in a standard 4:3 
format) 

 
 

In the GENERAL tab:  

 Ensure the settings are 
correct for working with 
PAL (25 frames/second) 
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When you click on OK, the 
screen will open up in Premiere 

 
 

 
 

N.B. 
 
If you are opening an existing project go to the project working folder on whichever drive you 
are using and double click the Premiere Project Icon for that project. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

  

In the TRACKS tab:  

 Select how many video and 
audio tracks you want in your 
sequences  

 As standard there are 3 Video 
and 3 Stereo Audio  
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PREMIERE SCREEN LAYOUT (Editing CS6) 
 
 
 
 
      Source Viewer        Program Viewer 
 
 
 
 

 
 
            
            Audio Levels 
Project Window 
 

Effects Window                   Sequence Window (for the editing)                 
 
                                         Toolbox (this may appear in different positions) 
 
 
If the Project window (bottom left) is not visible, select it. 
The name of the other windows are: Media Browser, Info, Effects, Markers and History 
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PREMIERE SCREEN LAYOUT (Editing CS5.5) 
 
 
 
Toolbox (this may appear in different positions) 
 
 
      Project Window               Source Viewer     Program Viewer 
 
 

 
 
 
 
            
            Audio Levels 
 
Effects Window                   Sequence Window (for the editing)                 
 
 
If the Project window (top left) is not visible, select it. 
The name of the other window in this area is: Resource Central 
 
If the Effects Window (bottom left) is not visible, select it. 
The other windows in this area area: Media Browser, Information and History 
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Once the Premiere programme is open, it is sensible to always check the following 
settings: 

       
Edit > Preferences > Autosave 

- Autosave a project every 5 or minutes (you can do a lot of work in 5 
minutes!) 

- maximum 15 or 20 saves  
 
 

Edit > Preferences > Media 
- Media Cache : 

Tick: Save next to originals if possible 
Create a file on Drive D for Premiere Media Cache 

- Create a file on Drive D for Premiere Media Cache Database 
- ‘Clean’ from time to time the Media Cache Database, 

particularly when you start a new project, or if you have problems 
during the edit.  
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AFTER OPENING A NEW PROJECT IN PREMIERE  
 

 Sort the positioning of the different information columns in the PROJECT SCREEN if 
necessary (they can be dragged across), a sensible layout is shown below. 

 
 

 Now create a bin (right click in the 
project area and select NEW BIN) 
and label the bin. 

 Create bins in the Project so that 
you can separate the different 
items e.g. Footage Voice Over, 
Interviews, Sequences, Captions, 
Music etc. 

 Bins can be opened and closed 
using the small triangle. 

 
 

 
 
 
 
 
 
 
 
TO IMPORT FOOTAGE FROM VIDEOCARDS 
 

 Change your workspace layout to Metalogging 
Window > Workspace > Metalogging 
 

 In the Project Window select the footage bin 

 In your Media Browser window find the folder where you transferred the files to 

 Select this folder, right click and select IMPORT 

 The folder (as a bin), and all the files, will now be in the footage bin  

 If you did not select the footage bin, you can move the new folder (bin)  
 

 Now open each clip in the source window (by double clicking), check what is on the clip 
and write a description for the clip 

 When you have described the clips, create more sub-bins so that you can group clips 
according to the subject 
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IF YOU ARE CAPTURING FROM VIDEOTAPE 

 
Once the Premiere programme is open, always check the following settings: 
 
Edit > Preferences > Capture 

- Normally tick the top 3 options on this screen 
- If you know you have a problem with dropped frames on the 

footage, then untick the option for abort capture on dropped 
frames, but realise that this will create a problem with editing 

 
 
Edit > Preferences > Device Control 

- Devices: set for DV/HDV Device Control 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Go to OPTIONS:  

 Video Standard : make sure you have the 
correct video system (PAL) this is VERY 
important as it will affect the controls when 
you are capturing footage. 
 

 Device Brand : Select the brand name of 
your equipment.   
 

 Device type: set to standard. 
 

 Timecode Format : 
Non drop frame  
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In the LOGGING tab area check: 
 

 SETUP:   
Capture:       Audio and Video 
Log clips to: Select the correct bin 

 CLIP DATA:   
Tape Name:  Insert the Tape name  
Clip Name:    Use the Tape name  

  CAPTURE:      SCENE DETECT 

In the SETTINGS tab area check: 
 

 CAPTURE LOCATIONS: ensure 
Video and Audio is set to the correct 
tape folder in the FOOTAGE and 
PROJECT folder 

 Use BROWSE and create a new 
folder for each tape 

 

 

TO CAPTURE FOOTAGE FROM VIDEOTAPE 
 

 Open your Capture Window (File > Capture, or use the key F5). 

 The Capture Window allows you to monitor the incoming video. 

 You can use the controls below the screen to control the videotape in the camera. 
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 Go back to the LOGGING tab. 

 Ensure the correct videotape is in the camera - and rewind it. 

 Play the videotape for a few seconds so you are certain you have picture, sound and 
timecode being captured. 

 Now in the CAPTURE section of the screen, click on TAPE. 

 The tape will be input into Premiere. As SCENE DETECTION is on, wherever the tape 
has been paused or stopped, a new clip will be created.  
N.B. Scene detection will ONLY work if the date and time have been set in the camera 

 

 While the tape is being captured the STATUS AREA at the top of the Capture Window 
will show details of the current capture (Clip Name, Capture Duration, Remaining Disk 
Space). 

 If you do not see this detail changing then stop the capture as you probably have 
forgotten to select SCENE DETECT. 
 

 When the tape gets to the end of the timecode (either the end of tape, or if there is a 
break in the timecode on the tape) it will stop capturing. 

 If it is because the timecode has ended, a window opens with the message:  
Capture stopped because blank tape was detected 

 If you do not see this message, click somewhere else on the Premiere screen and the 
message will reappear, or use ALT+Tab key to reveal this window. 

 Click OK to the message. 
 

 If you have recorded more footage on the same tape and you now want to input the 
new material, enter the tape number with ‘B’ after the number, and the same with the 
clip number, make sure you are capturing TO THE CORECT FOOTAGE FOLDER and 
to the CORRECT BIN. 

- Line the tape up at the point from where you want to capture 
- Make sure SCENE DETECTION is selected 
- Then select TAPE for capture 
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THE WORKING WINDOW LAYOUT FOR LOGGING  
 

 Select the METALOGGING layout. 
At the top of Premiere go to:  WINDOW > WORKSPACE > METALOGGING 

 Or on the top right of the screen you can select the workspace layout directly. 

 Open up the bin to log the footage. 
 

 
 

 For each clip, double click on the icon to open the footage in the viewer, look at the clip 
– you can use the scroll line to view quickly. 

 Decide on your description (use LS, MS, CU etc to describe the size of the shot) and 
then type in a description for any clips that are usable – this not mean you will use 
them, but they are usable…. 

 Tick if the clip is good. 
 If the clip is no good or is not going to be used, leave the description blank.  

 
 

 After you have put a description for each usable clip, you can delete clips that are not 
needed: 
- Select the clip, check it is definitely to be deleted ! 
- Right click and select  Make Offline 
- Now select the option for DELETE the media from the computer 
- Click OK, and on the next screen click OK again 
- Now go to the bin (notice the icon by the clip name has now changed) and delete 

the clip from the bin by using the DELETE key, or the BACKSPACE DELETE key. 
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 When all the clips have a 
description, create SUB BINS 
within the Tape Bin for different 
subject matters or topics. 

 
 

 Move relevant clips into these 
bins by selecting the clips and 
then dragging and dropping, or 
you may find it easier to select 
the clips and use cut and paste 
(CTRL+X and CTRL+V). 
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THE WORKING WINDOWS FOR EDITING 
 

THE SOURCE VIEWER 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 You can select IN and OUT points using  and  buttons (or I and O keys).  

 You have IN and OUT points set, the numbers on the right in white show the DURATION. 

 You can play between these clips using LOOP – this option is available in settings  . 

 You can delete an IN or OUT point by right clicking in the scroll bar and selecting  

CLEAR CLIP MARKER > IN AND OUT, or IN or OUT  

 You can go directly to the IN POINT using this key  and directly to the OUT POINT 

using this key . 

 You can MARK points on the source clip using this button . You can GO DIRECT to 
these points using the GO TO option available when you right click in the scroll bar. 

 The clip can be placed on the timeline by using the OVERLAY  or INSERT  
buttons (bottom right beneath the source window), or by dragging and dropping the clip 
from the source window onto the timeline. 

 If you are dragging and dropping and you only want to use the VIDEO from the clip, drag 

the video icon    from just below the picture.  

 If you only want to use the AUDIO, drag the audio icon  from just below the picture.  

 OVERLAY will cover up whatever is on the tracks which have been selected at the editing 
or IN POINT. 

 INSERT will move the pictures and sound to the right of the editing point further up the 
timeline (unless the tracks have been locked). 

  

 In the Project Window, open 
a bin and double click on a 
clip to open it in the Source 
Viewer. 

 You can use the YELLOW 
SCROLLER to quickly 
move through the video in 
the clip. 

 The numbers on the left in 
yellow show the 
TIMECODE at the blue 
scroller position. 
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THE PROGRAM VIEWER 
 
 

 
 

 The Program Viewer shows the image from the Sequence (wherever the yellow cursor is 
located). 

 The controls for the Program Viewer are the same as for the Source Viewer. 
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THE SEQUENCE WINDOW  
 
To create a new sequence 

 Select the Timeline bin 

 Go to:  FILE > NEW > SEQUENCE 

 Select the DV Widescreen 48Khz sequence (or whatever format is suitable for your 
footage) and give the sequence a name (it can also be renamed at any point). 

 Now click OK, the new sequence will be created in your Sequence bin and will open 
automatically in the Sequence Window. 

 You can also create a new sequence by selcting the ‘new item’ icon on the bottom of 
the project window.  

 

 You can DUPLICATE a sequence by right clicking on the sequence name in the Sequence 
Bin, then select DUPLICATE.  

 The sequence will be duplicated in the Sequence Bin with the word COPY beside the 
name.  

 RENAME this duplicated sequence (sequences can be renamed at any time). 

 This is useful when working on a new version of the edit or creating different language 
versions. 

 

 Open a sequence in the Sequence Window by double clicking on the icon in the bin. 

 Sequences can be closed by clicking the small cross beside the name.   
 

 
 

 The Sequence Window is where the clips are assembled to create the programme. 

 More tracks can be added by right clicking in the track name area of this window. 

 The tracks can be expanded by clicking on the small triangular arrow by the track name.  

 The tracks can be RENAMED by right clicking where the name is on the track and 
selecting RENAME. 
 

 You make the tracks ACTIVE for editing by clicking near the track name (the track 
information area turns light grey). 

 You select the target tracks for insert and overlay editing by moving the V and A1 tabs to 
the intended track, the tracks MUST be active. 
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 There are initally 3 video tracks and 3 stereo audio tracks, more can always be added. 

 More tracks can be added by right clicking in the track name area of this window and 
selecting the tracks to add. 

 It is imortant to be organised when editing and keep similar items on the same timeline. 

 A practical way of working is shown below : 
 
 

V4    Captions 

V3   Background pictures  

V2  Background pictures   

V1 Interview pictures    

A1 Interview sound    

A2  Background sound   

A3   Voice Over 1  

A4    Voice Over 2 
 

 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 

 A track can be locked so that the audio or video of a clip can be deleted or altered without 
affecting the other part. 

 Check that the track sync lock symbol on the video and audiotracks are selected.  
 

 An audio track can be muted by clicking on the loudspeaker symbol. 

 A video track can be switched off by clicking on the ‘eye’ symbol. 
 

 The selected sequence can be started and stopped from the timeline by using the 
spacebar.  

 
  

 This symbol is the SNAP tool   .  
If it is switched on, when you move, or 
drag and drop clips, it makes the clip 
‘snap’ to the edit point. Usually it is 
best to keep the snap tool ‘on’ and 
only switch it off when you specifically 
want to. 

 

 Locking a track by using the padlock symbol 
located near the track name can also be used to 
‘protect’ the track from being affected by insert 
edits or the ‘ripple delete’ function.  

 The locked tracks are indicated by slanted lines 
over the track area.     
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MOVING AROUND THE SEQUENCE 
 

 To move along the sequence, use the yellow scroller attached to the red line. 

 You can use the keys L and J to play the sequence forwards and backwards, and the  
K key to pause. 

 If you press L or J twice the footage will play faster. 

 Use the + and – keys to expand and reduce the sequence view. 

 The slider on the bottom left of the window can also be used to expand or reduce the 
size of the sequence view. 

 

 The yellow timecode numbers on the top left of the sequence indicate the exact position 
of the yellow scroller. 

 
 
 
 
 

You can copy and paste a picture on the time line 
using CTRL+C and CTRL+V keys 

 
You can cut and paste using  
CTRL+X and CTRL+V keys 
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THE TOOLS WINDOW 
 

 

A. Selection tool 
 

B. Ripple Edit tool 

C. Rate Stretch tool 

D. Slip tool 

E. Pen tool 

F. Hand tool 

G. Track Select tool 

H. Rolling Edit tool 

I. Razor tool 

J. Slide tool 

K. Zoom tool 

 

Selection Tool (Key V) 

 This is the tool that is used most of the time. 

 ALWAYS return to this tool after using any of the other tools. 
 
Track Select Tool (Key A) 

 Select this tool (a black arrow) to select all the clips to the right of the cursor in a sequence. 
To select a clip and all clips to the right in that track, click the clip.  

 Holding the Shift key with Track Select Tool switched on changes the Track Selection Tool 
into a MULTI-TRACK Selection Tool (two black arrows), this enables all tracks to the right 
of a selected clip to be selected. 

 If a track has been locked it cannot be selected.  

 If you use the Track Select tool, return afterwards to the Selection tool. 
 

Razor Tool   

 Select this tool to make one or more incisions in clips in the sequence. Click a point in a 
clip to split it at that precise location. To split clips in all tracks at that location, hold the 
SHIFT key down. 

 If you use the RAZOR cutting tool to cut an edit, return to the SELECTION tool afterwards 
to avoid accidentally cutting another edit. Also make sure you have the correct track 
selected for cutting. 

 
 

 If you want to cut a shot exactly where the scroller bar  
is located in the sequence use : 

 

CTRL+K keys 

 
This is the fastest  and most accurate way of cutting a shot. 

Only ACTIVE tracks (pale grey) will be cut. 
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ADJUSTING AUDIO  
 
THE AUDIO MIXER 
 

 Audio for a whole track can be adjusted using the AUDIO MIXER (a tab for accessing this 
is found beside the Source Window). 

 

 
 

 Use the fader to increase or decrease the audio level across the whole track. 

 This option is mostly used for the BACKGROUND audio, as generally this will all need to 
be decreased.  

 It is also useful for increasing a recorded voice track where the voice is at level that is low. 
 

 When playing back your programme before final output to tape or DVD, have the Audio 
Mixer window up so that you can visually check that none of the sound levels are too high. 
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 ADJUSTING AUDIO FOR A CLIP 
 

 
 

 To adjust audio for an individual clip you need to expand the relevant audio track (using the 
small triangle by the track name). 

 If you move the mouse pointer over the yellow line on the audio track you will see it change 
shape to indicate a flat line, whilst in this format you can increase or decrease the audio 
level of that clip.  

 Hold the left button of the mouse down when altering the audio level of a clip. 

 Altering the sound level of an individual clip is still possible even if the audio mixer has 
been used to lower or raise the sound level of the whole track. 

                
ADJUSTING AUDIO USING KEY FRAMES 
 

 Audio will need to be adjusted using key frames particularly where there is an interview in 
one language and there is the translation voice on another track. 

 Ideally you should hear the interviewee talking in their language first, this then fades to a 
lower level before the translation voice is heard. 

 Two key points need to be added before the translation voice so that the level can be 
lowered. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
If the translation voice is shorter than the interviewee actually speaking, you can enter 

two more key points and raise the interviewee voice at the end of the interview.  

 

 Select the clip. Add a key 
point by positioning the blue 
scroller bar at the point for 
the key point, then click on 
the key point tab. Move to the 
next position for the key point 
and do the same. Lower the 
sound level for the clip after 
the two key points and you 
will see a visual interpretation 
of the sound level going 
down. 
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ADJUSTING VIDEO  
 

EFFECT CONTROLS 
 

 There are three effects which can be altered in a video clip without adding an effect from 
the effects panel, these are: 

- MOTION 
- OPACITY 
- TIME REMAPPING 

 

 MOTION will be described later in the section on INSETTING A CLIP. 
 

 You may want to adjust VIDEO OPACITY for an individual clip to make it darker so that 
you can use it as a background for captions.  

 Expand the relevant video track (using the small triangle by the track name). 

 If you move the mouse pointer over the yellow line on the video track you will see it change 
shape to indicate a flat line, whilst in this format you can alter the opacity level of the clip. 

 Hold the left button of the mouse down when altering the opacity level of a clip. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
TIME REMAPPING is an advanced feature and is rarely used. 

 By selecting the altered clip 
and then clicking on the 
EFFECTS CONTROL 
window next to the source 
window you will be able to 
see exactly the opacity level 
you have set. You can also 
alter the level directly in this 
window. 
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APPLYING A VIDEO or AUDIO TRANSITION or EFFECT 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
TRANSITIONS 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 To DELETE A TRANSITION, click on the transition in the clip and use the DELETE key. 
 
 
 

 Open the EFFECTS PANEL on the left of the 
Sequence Window. 

 Open the bins to select a transition (or effect). 

 Drag and drop the transition (or effect) on to your clip. 
 

 If you applied a 
TRANSITION, 
double click the 
transition in the 
timeline and then go 
to EFFECTS 
CONTROL PANEL. 

 Tick SHOW 
ACTUAL 
SOURCES so you 
can see the effect 
with the actual 
pictures. 

 You can alter the 
transition duration 
and other 
parameters here. 
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EFFECTS 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Reset an effect by clicking the RESET symbol   on the right of the effect. 

 Switch an effect OFF by clicking the fx symbol beside the effect name. 

 DELETE an effect by clicking on the effect name and hitting the DELETE key. 
 
 

 You can COPY AND PASTE an EFFECT from one clip to another by :  

 Selecting the clip with the effect  

 Copying it (CTRL+C or right click and select COPY) 

 Go to the clip (or clips) where you want to apply the effect, select the clip 

 Right click and then select PASTE ATTRIBUTES 

 All effects from the original clip will be applied to the new clip 
 
 

AUDIO TRANSITIONS and EFFECTS  
 

 AUDIO EFFECTS AND TRANSITIONS work in similar ways, but do not usually have to be 
rendered (see next page). 

 

 If you applied an EFFECT, 
click on the clip where you 
have applied the effect and 
then go to the EFFECTS 
CONTROL PANEL.  

 Click on the small triangle 
to open and view the 
effect. 

 You can then adjust the 
effect (example on the left 
shows a Drop Shadow 
effect). 
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RENDERING EFFECTS AND TRANSITIONS 
 
 

 
 

 Most effects and transitions will play on the sequence, but a red area above the sequence 
indicates that this section will have to be RENDERED before the programme is exported as 
an encode or recorded to tape. 

 
 

 To render, first select the sequence. 

 Make sure the work area bar is the same length as the sequnce to be encoded 
 
 
 

    
 
 

 Now click on SEQUENCE at 
the top of the Premiere screen 
and select Render Effects in 
Work Area.   

 Or select the sequence to be 
rendered and use the ENTER 
key. 

 
 

 After rendering the red line will 
now be green at the top of the 
sequence.  
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TO SCALE A SHOT and PLACE ONE 
SHOT WITHIN ANOTHER  

 

 To scale a shot on the sequence, first decide what you want in the background when the 
picture is scaled down, the background needs to be on Video 1. 

 The shot to be scaled must be on Video 2. 

 Double click on the shot to be scaled so that it opens in the source viewer. 

 Next click on the Effect Controls tab beside the source window. 

 Click the small triangle beside Motion to see the motion options, including Scale.  

 Then click on the triangle beside Scale. 
 

 
 

 Now use the sliding scale (0.0 to 100.0) to reduce the picture size to the scale you want, or 
click on the numbers beside Scale and type the figure in direct. 

 Now go to the timeline and play the effect. Adjust as necessary. 
 

 The position of the scaled picture can also be changed. 
 

 
 

 Move to the program viewer and select the scaled down picture and move it to the position 
you want. Now play the effect on the sequence. 

 Having SAFE MARGINS icon selected will make sure the inset 
picture is not too near the edge of frame. 
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 DROP SHADOW 
 

 Next to make the inset picture look good and separate it from the background you 
can add a DROP SHADOW (see also Page 23). 

 From the EFFECTS PANEL select :  

 VIDEO EFFECTS > PERSPECTIVE > DROP SHADOW 
 

 Select the drop shadow effect and drag it on to the clip in the sequence. 
 

 Go to the EFFECT CONTROLS PANEL and alter the drop shadow as you 
want. 

 
 
 

 
 
 
 
 



Page 31 
© 2013            

                       

BEVEL EDGES 
 
 

 If you want to make the inset picture stand out from the background, another easy way is to 
use BEVEL EDGES. 

 From the EFFECTS PANEL select :  

 VIDEO EFFECTS > PERSPECTIVE > BEVEL EDGES 
 

 
 
 

 
 
 
 
 
 

 
 
 

  

 Pick up this effect and 
drag it on to the clip on the 
sequence. 

 

 Go to the EFFECT 
CONTROLS PANEL and 
alter the bevel edges as 
you want. 
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 It is possible to combine the effects of bevel edges and drop shadow. 

 You can apply a fade up on the clip as well if you want. 
 

 Don’t forget to render the effect and save your project. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

REMEMBER: 
 

YOU CAN DELETE ANY EFFECT FROM THE EFFECT CONTROL WINDOW BY 
CLICKING ON THE EFFECT NAME AND THEN USING THE DELETE KEY. 

 
YOU CAN SWITCH OFF AN EFFECT TEMPORARILY BY CLICKING 

ON THE fx SYMBOL TO THE LEFT OF EACH EFFECT NAME. 
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TO CREATE A STILL FRAME 
 
 

 Select the clip on the sequence that you want to make as a still frame. 

 Right click and select:  FRAME HOLD 
 
 

 
 

 
 

 In the Frame Hold Options Window, tick the HOLD ON box:  
- You can select to hold on In Point, Out Point or a Marker, the most usual would 

be IN POINT 
 

 
 

 Click on OK 

 You will have to render the still frame. 
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TO CHANGE THE SPEED OF A CLIP and REVERSE PLAY A CLIP 
 
 

 One method to change the speed of a clip is to select an IN and OUT point on the 
sequence, and ALSO an IN and OUT point on the clip. 

 When you click on OVERWRITE a window appears, select the top option :  
Change Clip Speed (Fit to Fill) 

 
 

 
 

 

 Click on OK 

 You will have to render the effect. 
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 An alternative method is to select the clip on the sequence, right click with the mouse 
and select : SPEED / DURATION 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 From the Clip Speed / Duration window you can alter the speed of the clip, or even 
make it play in reverse. 
 
 

 
 Selecting MAINTAIN AUDIO 

PITCH in this window means the 
audio will play at normal speed 
even if the video speed or 
direction is altered. 
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IMPORTING A GRAPHIC 

 
 

 Select the bin you want to import the graphic into. 

 Right click, select IMPORT and import the file you need. 

 Many different formats of file can be imported. 

 Once imported, double click the imported graphic and it will open in the source viewer 
(layered Photoshop files will work differently). 

 Position the image on the timeline. 

 You will probably need to alter the SIZE of the image on the sequence. The size is altered 
exactly like altering the size of any other clip. 

 

 If you are importing a still photograph or graphic which is very large, the editing software 
may not work properly, if this happens, resize the pictures/graphics before importing. 

 
 

 You can use the PAINT programme on your computer to resize an image (reduce the 
number of pixels). 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Note that the PIXEL size for 
 

PAL 4:3 (standard) format is:  720x576 
PAL 16:9 (widescreen) format is:  1024 x 576 
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HOW TO CREATE A SUB-SEQUENCE  
 

 If you want to insert a number of images, like below, it is easier to create this in a different 
sequence. 
 

 
 

 If you want the timing of the photos to be accurate to the voice, copy the relevant part of 
the voice from the main sequence. 

 Then arrange the shots on different tracks. 
 

 
 

 Once you have created the sub-sequence, you drag and drop this sequence from the bin in 
the project window, and place it in the main edit sequence. 
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CROPPING  
 

 If certain photographs or video clips need to be cropped, first select the clip in the 
sequence. Then go to the Effects Window and select : 

 

Video Effects  > Transformation > Cropping 
 

 Drag and drop the effect onto the clip or picture to be cropped. 

 Double click on the clip to open it in the Source Viewer. 

 Select Effect Controls 

 Click on the small triangle next to Cropping and you can crop the clip. 
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TITLES and CAPTIONS 
  

 There is a specific titling /captioning programme within Premiere. 

 Before creating a caption, on your sequence, place the blue scroller bar at the point where 
you want the caption to appear. 

 Go to the Project Window and create or select the CAPTION BIN. 

 Go to: FILE > NEW > TITLE      (or select the New Item icon and choose Title) 
 
 
 
 
 
 
 
 
 
 

 
 
 

 There are two thin lines in the Titling window: 
- the area outside the outer line is the CUT-OFF AREA and will not be seen if the video is 

shown on domestic televisions. 
- captions need to be placed within the TITLE-SAFE area (inside the inner line) to be 

certain they can be read and they will not be ‘cut-off’ or be on the very edge of frame. 
 

 
 

 
 

 

 A NEW TITLE window will appear. 

 Enter the NAME for the caption you are creating, 
click OK. 

 The CAPTION (TITLE) WINDOW will open with the 
background picture from the sequence. 

 If the background picture does not appear,  

 click on the Show Background Video button  
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 Captions can either be created using the TITLER STYLES below the monitor window, the 
tools on the left of the monitor window, and Title Properties on the right,  or you can create 
them yourself. 

 

 Every caption can be easily altered and resized as in most graphics programs. 
 

 There are a large number of TEMPLATE styles of titles and captions which can be adapted 
for your programme. 

 To access the templates go to the symbol shown bottom right of these three 
symbols. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Once your title or caption has been created, close the Title window (you do not ‘save’ as 
this is done automatically). 

 The caption will appear in your CAPTION BIN. 
 

 Drag the caption down onto the sequence and then place it on the video track for captions 
(usually Video Track 3). 

 
 

 One of the most useful 
selections is in the 
folder for LOWER 
THIRD CAPTIONS. 

 

 The duration can be altered 
by stretching the caption 
along the timeline. 

 TRANSITIONS can be 
applied to the caption like 
any other clip. 
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To Create Another Caption by Altering an Existing One 
 

 To create another caption by altering an existing one, go to the bin, select the caption you 
want to alter, right click and select duplicate, then give the duplicate caption a new name. 

 Double click the newly named caption and then alter it within the Title Window. 
 
 
To Export and Save a Caption for Use in Future Projects 
 

 To export and save the caption for importing into future projects select the caption to 
export. 

 Go to FILE > EXPORT > TITLE 

 In the export window create a folder to save the captions into (TITLES and CAPTIONS), 
make sure the name of the file you save is the same as the caption, then click SAVE. 

 Your caption or title will be saved into the folder in a format which it can then be opened in 
another project. 

 It is sensible to do this for ALL the captions you create for your project. 
 
  

 

NOTE 
 

If you double click on a title or caption from within the sequence or bin,  
it will open in the Titling Window 

 



Page 43 
© 2013            

                       

EXPORTING FILES for TRANSCRIPTIONS and TRANSLATIONS 
 

 Have the relevant sequence open in the sequence window. 

 If necessary, lower or increase the audio level using the audio mixer. 

 Make sure the correct Sequence is selected (it will have a yellow line around it).  

 Before exporting the sequence, go to the Effects Window : 
From Video Effects, open Video and select : Timecode  

 Drag and drop this effect on the first clip in the interview sequence interview. 
 

 
 

 Open the effect in the Effect Controls window.  

 Click on the small triangle next to Timecode and select : 
Format :     SMPTE 
Timecode Source :   Media (this is very important !) 
Time Display :     25 (this is very important !) 

 The clip in the sequence now shows the numbers from the timecode of the original tape. 

 Now alter the SIZE of the timecode numbers : 
- Click on the small triangle beside Size 
- Use the sliding scale to alter the size of the numbers so they can be read easily  

 

 Copy this effect on to all the clips in the sequence. 

 Use COPY (CTRL+C) and then PASTE ATTRIBUTES : 

 To copy, select and then use or right click and select COPY.  

 Go to the clip you want to apply the effect to, or select all the clips. 

 Right click and select PASTE ATTRIBUTES. 

 All the clips in the sequence should now show original timecode. 

 The numbers will indicate timecode from the original casette. 

 If you are working in a language you do not understand you can use the timecode to 
identify exact points in the interview with the person who has transcribed and translated the 
interview.  

 Now render each interview sequence (the redline will turn green). 
 

 Now select the each sequence and go to :  
FILE > EXPORT > MEDIA 

 The Export Settings window opens. 
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In Export Settings: 
 

 
 
 

 For Format:          select a useful format, e.g. Windows Media or FLV 
 

 For Preconfiguration : select a useful preconfiguration  
e.g. PAL Widescreen Source to High Quality Download 

 

 For Output Name : click on the yellow output name and create or select the folder you want 
to save the file to (by default the file name will be the same as the sequence name) 

 
 

 Now click EXPORT at the bottom of the Export Settings window. 

 The sequence will now be encoded. 
 
 
 

 IF you have a number of files to export, click on Queue instead of Export. 
 

 Adobe Media Encoder will now open. 
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ADOBE MEDIA ENCODER 
 

 If you have forgotten to save the file to a particular folder, or to give it the file name you 
want then you can still do this by clicking on the Output File. 

 

 
 

 Now return to Premiere and select a new sequence to export, repeat the same actions. 

 Now when you go to Adobe Media Encoder, you will find another file to encode. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
  

 The sequences you have 
selected will now encode. 

 

 A green tick will apear next to 
the file name when it has 
encoded. 

 

 When you are ready, click the small green 
triangle top right of the encoder screen. 
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HOW TO EXPORT A SEQUENCE 
 

 Open and select the sequence you want to export. 

 Before encoding a programme, make sure you have played through the programme and 
are certain that the sound levels are balanced (MAXIMUM levels should be -6db, voice 
levels should ideally be between -12db and -6db). For the balance of the audio channels, 
make sure you are listening on headphones, it is not good enough to only listen on 
speakers.  

 Ensure that the grey work area bar covers the whole of the programme, this is the bar with 
yellow ends immediately above the top video track. 
 

 
 

 Complete all renders (SEQUENCE > RENDER EFFECTS IN WORK AREA and to be safe 
also RENDER AUDIO). 

 You can also select the sequence to be rendered and use the ENTER key. 
 

 Select the sequence, then select : FILE >  EXPORT > MEDIA 

 The Export Settings window will open. 
 

 Now make your selections as described in the previous section.  
 

 If you want to encode more than one sequence, use Adobe Media Encoder as described 
previously. 
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RECORDING TO DIGITAL TAPE  
 

 Before recording a programme to digital tape, make sure you have played through the 
programme and are certain that the sound levels are good (MAXIMUM levels should be  
-6db, voice levels should ideally be between -12db and -6db.  

 Also ensure that all renders have been completed. 
 

 Before connecting the camera for outputting the tape, insert the tape to record on to and 
record a minimum of 30 seconds of COLOUR BARS. 

 You do not want sound recorded on this, so plug in the external microphone but do not 
switch it on. 
 

 Now put the camera into to PLAY/EDIT mode. 

 Connect the camera with the Firewire cable. 
- It is ALWAYS better to connect the camera BEFORE going in to Premiere Pro 

 Always have the camera running from mains when editing (preferably through a UPS)  

 Now go into your project in Premiere. 
 

 Go to the PROJECT WINDOW, right click and select  
New Item > Bars and Tone and then New Item > Video Black.   
OR FILE > NEW > BARS AND TONE  for Colour Bars and Tone 

FILE > NEW > BLACK VIDEO   for Black 
 
 
 
 

 In the window that opens, select :  
        D1/DV PAL Widescreen 16:9 
 
 
 
 
 
 
 
 

 
 

 The duration of Bars and Tone and the Video 
Black can be changed by right clicking item in the 
bin, select Speed / Duration and then type the 
number of minutes and seconds as necessary. 

 This example shows a duration of 1 minute. 
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 Create a NEW SEQUENCE in your sequence bin, name it as PLAYOUT.  

 Open the Playout sequence in the Sequence Window. 

 Place 60 seconds of COLOUR BARS on this timeline followed by 30 seconds of BLACK. 
 

 Now drag and drop your EDITED SEQUENCE from the Sequence Bin onto the Playout 
Sequence – your edited sequence is ‘NESTED’ within the Playout Sequence. 

 Now place 1 minute of BLACK at the END of the programme. 
. 
 

 
 

 The colour bars and tone are used for checking video and audio levels when making VHS 
copies of the programme.  

 The black at the start is used to give a run-in to the programme and the black at the end 
provides a clean signal after the programme has finished. 

 

 Make sure the work area bar covers the whole length of the programme 
 

 Now go to:  Sequence > Render Effects in Work Area  
 

 Also render the audio : Sequence > Render Audio 
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BEFORE RECORDING ONTO TAPE…. 
 

 Select the Playout sequence in the sequence window.  

 Select: Sequence > Sequence Settings > Playback Settings 

 Realtime Playback CHANGE THE AUDIO SETTING TO  

         EXTERNAL DEVICE AUDIO 

 If you don’t select this setting you will have NO AUDIO on the videotape! 
 

 
 

 Click on OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 In the window 
Sequence Settings, 
click on OK. 
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 Now select: FILE > EXPORT > EXPORT TO TAPE 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

ALWAYS make sure you have  
TWO COPIES OF A MASTER PROGRAMME 

(this is your ‘insurance’!) 

 
 
 
 

AFTER RECORDING TO TAPE GO TO Playback Settings 
AND SELECT DESKTOP AUDIO 

 
 
 
 

 From this window select: 
- ACTIVATE RECORDING DECK 
- You can now set the timecode 

where you want the recording to 
start (in this example at 30 
seconds)   

- If it is not a new tape, select a 
sensible timecode for the recording 
to start.  If you are recording onto a 
tape that has other programmes 
then you may not need to have 
colour bars on your programme 
timeline – but you should always 
have some black before and after 
the programme. 

 Now press the Record option and the 
computer will take over! 
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MAKING MULTIPLE LANGUAGE VERSIONS of your 
PROGRAMME 
 

 Before a new language version can be made, your programme must be translated 
accurately into the new language.  

 Check your final script against the programme and make sure that the words on the script 
are accurate. 

 TIME each section (shot) of voice, this timing should be noted on the script. 

 It is best to make the script into a landscape format so that an extra column can be added 
for the translation, for example… 
 

Script 02: Seed Sorting by Flotation 

Draft: FINAL  Duration:   06’50”  Word Count: 760  Date: June 30 2009 

 
 

Shot Video Audio English 
 

Audio LOCAL Duration 

1 Title Caption: 
Seed Sorting By 
Flotation 
 

   

2 Clean seed sample Improving the quality of farmers’ seed is very 
important for Bangladesh because more than 
95% of the farmers use their own seed.  
 
But if you want a good yield, you must start 
with healthy seed. 
 

 18” 

3 Sample with insect Farmer-saved seed is generally of poor quality 
because of contamination, mostly from insects 
and diseases. 
 
Seed damaged by insects or unripe seeds are 
much lighter than healthy seed so it is easy to 
get rid of these light seeds. 
 

 20” 

4  Let’s have a look at how women in Maria 
village, near Bogra in Bangladesh, use a 
method called the seed flotation technique to 
improve their seed quality. 
 
 

 12” 

 

 If possible the translation of the script should be done on computer, but there are times 
where the translation will have to be handwritten. 

 Finding GOOD people to translate the programme accurately and then record the voice 
over in the new language is not easy. It is not worth taking shortcuts. 

 Before recording, always check the translation of the programme with colleagues. 

 The timings that have been noted for each part (shot) of the script are important when the 
voice is recorded so that you can be certain the new voice will be the same duration. 

 If possible always record the voice in a proper sound studio, where the timings can be 
easily checked.  

 If possible, record the audio files as 48KHz WAV files, as this is the format for digital video. 

 44.1Khz or mp3 audio files are also useable. 
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 The audio file(s) of the new voice can be transferred into the editing computer. Make sure 
you put them in a folder WTIHIN your project folder.  

 Import them into Premiere Pro: in a bin you have created, right click and select import. 
 

 Before starting to make another language version of your programme, first DUPLICATE 
the final edited sequence. Select the sequence in the Sequence Bin, right click, select 
duplicate, then give this version of the programme a new name (the new language). 

 Double click this new sequence to open it the sequence window. 

 Lock the video and audio tracks (see Page 18). The aim is always to keep the programme 
the same length. 
 

 
 

 Add a new audio track (see Page 18). The new audio files can then be placed on this track.  

 Use the original voice track (usually in English or French) as your guide for placing the new 
voice files in the correct position. 

 Once the new voice files are in the correct position, you can MUTE the guide track (see 
Page 18). 
 

 Now check the audio levels of the new voice in relation to the programme.  
USE HEADPHONES!!! 

 It is best to use the audio mixer to raise or lower the levels if necessary. Remember you 
can alter the audio level within an individual clip as well (see page 20). 

 

 If during an interview, the interviewee was talking in the new language, then obviously this 
does not need translating, but the sound level for the interviewee must be brought up to 
normal levels so that people can clearly hear what they are saying (you will have to unlock 
the relevant audio track to do this). 
Once all the new audio is in the correct place, and all audio levels have been checked and 
adjusted, then this new programme can be exported or recorded onto tape. 
 

Why keep the translated programme the same length? 
 

 Because when you are making multiple translations of programmes it is easier and less 
work if the programme is kept the same length. 

 Because if a multiple programme / multiple language DVD is being made of the 
programmes, the aim is to keep the visual element of the DVD the same, and only the 
audio tracks change. This means that more programmes can be put on one DVD, therefore 
saving on duplication costs 
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Captions… 
 

 Changing captions is generally not needed. 

 If you want or need to change captions into this new language, first make sure you have all 
the captions correctly translated (and spelt). 

 DO NOT just change the captions that are on the new timeline as you will be changing 
them in the original programme, you must first duplicate them and then alter them (see 
page 40). 

 Then place the new captions either to replace the original ones, or on a new video track – 
and then ‘switch off’ the original caption track (see page 18).  
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ARCHIVING YOUR PROJECT 
 

 
When you have finished the project you are working on it is sensible to archive your project 
so that you can recreate it if necessary at any point in the future. 
 
Your working folder should contain: 

 The Project file 

 Any titles you have created. 

 Any graphics you have used. 

 You can also add to this a file for each bin in your project, this can be used when 
recapturing, but it is not essential to create it. If you want to create a bin file, select 
the bin, right click and select Export Bin from Project. 

 Make sure you are in the correct working folder, then save the bin. 
 
Now look at the folder where the video and audio files were recorded. 

 Put any audio WAV files (particularly music files which do not have a timecode 
reference) for archiving as well. 

 
Burn this working folder onto a CD or DVD – it is probably best if you use one disc per project. 
 
 
 

 

USEFUL WEBSITES 

 
 

www.adobe.com/support/contact   
 
www.forums.adobe.com/community/premiere  
 
http://premierepro.wikia.com/wiki/Adobe_Premiere_Pro_Wiki 
 
www.creativecow.net  (forums, blogs, training, tutorials) 
 
www.dvinfo.net  (forums, blogs, training, tutorials) 
 
www.larryjordan.biz  (forums, blogs, training, tutorials) 
 
www.lynda.com  (training, tutorials) 
 
 
  

http://www.adobe.com/support/contact
http://www.forums.adobe.com/community/premiere
http://premierepro.wikia.com/wiki/Adobe_Premiere_Pro_Wiki
http://www.creativecow.net/
http://www.dvinfo.net/
http://www.larryjordan.biz/
http://www.lynda.com/
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NOTES 
 

 


